

    
      
          
            
  
Sensor Kit V2 for Arduino


About the Sensor Kit for Arduino 2.0

The kit is suitable for SunFounder Uno, Mega 2560, Duemilanove and Nano and also fully compatible with the corresponding Arduino boards. It includes 37 various modules for you to learn and we provide corresponding lessons which are simple and useful for better understanding. Hope you can learn their applications quickly and use them in your own projects!

Here is the Email: cs@sunfounder.com.
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Components









	No.

	Name

	Qty.

	Component



	1

	Analog Hall

	1
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	2

	Hall Switch
Sensor

	1
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	3

	Analog
Temperature
Sensor

	1
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	4

	Auto Flash LED

	1
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	5

	Ba
rometer-BMP180

	1
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	6

	RTC-DS1302

	1
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	7

	Flame Sensor

	1
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	8

	Gas Sensor

	1
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	9

	Humiture
Sensor

	1
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	10

	Joystick PS2

	1
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	11

	Button

	1
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	12

	Vibration
Switch

	1
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	13

	Touch Switch

	1
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	14

	Photo -
interrupter

	1
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	15

	Photoresistor

	1
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	16

	Reed Switch

	1
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	17

	Potentiometer

	1
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	18

	Relay Module

	1
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	19

	Thermistor

	1
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	20

	Tilt-Switch

	1
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	21

	Active Buzzer

	1
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	22

	Passive Buzzer

	1
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	23

	Temperature
Sensor DS18B20

	1
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	24

	RGB LED

	1
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	25

	IR Receiver

	1
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	26

	Dual-Color LED

	1
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	27

	Sound Sensor

	1
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	28

	Rotary Encoder

	1
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	29

	Laser Emitter

	1
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	30

	Tracking
Sensor

	1
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	31

	IR Obstacle
Sensor

	1
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	32

	Color Sensor

	1
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	33

	AD/DA
Converter
PCF8591

	1
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	34

	Raindrop
Sensor

	1
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	35

	Ultrasonic

	1
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	36

	Remote
Controller

	1
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	37

	I2C LCD1602

	1
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	38

	Breadboard

	1
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	39

	USB Cable

	1
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	40

	5-Pin
Anti-reverse
Cable

	5
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	41

	3-Pin
Anti-reverse
Cable

	5
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	42

	4-Pin
Anti-reverse
Cable

	5
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	43

	2-Pin
Anti-reverse
Cable

	2
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	44

	2-Pin Ribbon
Cable
(F to F)

	1
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	45

	Dupont Wire
(M to F)

	10
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	46

	Dupont Wire
(M to M)

	10

	[image: _images/image49.jpeg]



	47

	Dupont Wire
(F to F)

	10
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Get Started


Note


	Before starting your own project, you must download the file Sensor Kit V2.0 for Arduino.zip [https://drive.google.com/file/d/1Fy88ikH1sagteuxBZaaE4dZ7XdAdr1pf/view?usp=sharing] on our official website by visiting LEARN -> Sensor Kit V2.0 for Arduino and unzip it.


	Besides, a visual programming language software-Mixly is also
provided. It can help you to complete the lessons quicker and easier.
Mixly is a graphical programming software with some blocks embedded
in. You can program by dragging and dropping blocks to combine
together like building blocks, thus enabling a complete process of
the same sketch in IDE. Download the file: How to use Sensor Kit
with Mixly.zip on our official website by visiting LEARN ->
Get Tutorials -> Sensor Kit V2.0 for Arduino and unzip it.







SunFounder Arduino Board

[image: _images/image51.jpeg]
Now, SunFounder has five Arduino boards: SunFounder Uno R3 Board, Mega 2560 Board, Nano Board, SunFounder Mars Board and SunFounder Mercury Board. The Uno Board and the Mars Board share the same kind of pins at the same position. And the pins of the first half part on the Mega 2560 are the same as those on the Uno. The difference lies in that on the Mega 2560 board, the I2C pin (SDA) and pin SCL don’t correspond to pin A4 and A5 but to pin 20 and 21. On the other hand, the Nano and the Uno also share the same kind of pins at the same position. Though the Nano is in a smaller size, making it applicable for projects.

The following is the parameters of the four boards:











	Board

Parameters


	Uno R3

	Mars

	Nano

	Mega
2560

	Mercury



	Mic
rocontroller

	AT
mega328P

	AT
mega328P

	AT
mega328P

	ATm
ega2560

	AT
mega2560



	USB
connection

	Type B

	Type C

	Mini-B

	Type B

	Type C



	U
SB-to-Serial
Chip

	MEGA16U2

	FT232R

	PL2303

	M
EGA16U2

	FT232R



	Power jack?

	Y

	Y

	N

	Y

	Y



	Operating
Voltage

	5V

	5V

	5V

	5V

	5V



	Input
Voltage

	7-12V

	7-12V

	7-12V

	7-12V

	7-12V



	Digital I/O
Pins

	14 (of
which 6
provide
PWM
output)

	14 (of
which 6
provide
PWM
output)

	14 (of
which 6
provide
PWM
output)

	54 (of
which
15
provide
PWM
output)

	54 (of
which 15
provide
PWM
output)



	Analog Input
Pins

	6

	6

	8

	16

	16



	DC Current
per I/O Pin

	20 mA

	20mA

	20 mA

	20 mA

	20 mA









Install Arduino IDE

The code in this kit is written based on Arduino, so you need to install the IDE first. Skip it if you have done this.

Now go to arduino.cc [http://www.arduino.cc] and click DOWNLOAD.
On the page, check the software list on the right side under Download
the Arduino Software.

[image: _images/image52.png]
Find the one that suits your operation system and click to download.
There are two versions of Arduino for Windows: Installer or ZIP file.
You’re recommended to download the former. Just download the package,
and run the executable file to start installation. It will download the
driver needed to run Arduino IDE. After downloading, follow the prompts
to install. For the details of installing steps, you can refer to the
guide on Learning->Getting Started with Arduino, scroll down
and see Install the Arduino Software.

After installing, you will see Arduino icon on your desktop and double
click to open it.

[image: _images/image53.png]



Plug in the Board

Connect the control board to your computer with a USB cable. If you use
Uno, Mega2560 or Mars as the control board, the system will
automatically install the driver when you plug it in. After a while, a
prompt will show up at the bottom right corner telling you which port
the board locates at.




Add libraries


	What is Library?




A library, gathering some function definitions and header files, usually
contains two files: .h (header file, including function statement, Macro
definition, constructor definition, etc.) and .cpp (execution file, with
function implementation, variable definition, and so on). When you need
to use a function in some library, you just need to add a header file
(e.g. #include <LiquidCrystal_I2C.h>), and then call that function. This
can make your code more concise. If you don’t want to use the library,
you can also write that function definition directly. Though as a
result, the code will be long and inconvenient to read.


	How to add libraries?




Some libraries are already built in the Arduino IDE, when some others
may need to be added. So now let’s see how to add one. There are two
methods for that.

Method 1

Directly import the library in Arduino IDE (take LiquidCrystal_I2C as an
example below). The advantage of this method is easy to understand and
operate, but on the other hand, only one library can be imported at a
time. So it is inconvenient when you need to add quite a lot of
libraries.

Step 1: Select Sketch -> Include Library -> Add ZIP
Library.

[image: _images/image54.png]
Step 2: Find Sensor Kit V2.0 for
ArduinoLibraryLiquidCrystal_I2C, Click Open.

[image: _images/image55.png]
Step 3: When you see “Library added to your libraries. Check
“Include library” menu”, it means you have added the library
successfully. Please use the same method to add other libraries then.

[image: _images/image56.png]
Method 2

Directly copy the library to libraries/Arduino path. This method can
copy all libraries and add them at a time, but the drawback is that it
is difficult to find libraries/Arduino.

Step 1: Click File -> Preferences and on the pop-up window
you can see the path of the libraries folder in the textbox as shown
below.

[image: _images/image57.png]
Step 2: Copy all Libraries in the path Sensor Kit V2.0 for
ArduinoLibrary\.

[image: _images/image58.png]
Step 3: Go to the path above and you will see there is a Libraries
folder, click to open it.

[image: _images/image59.png]
Step 4: Paste the libraries copied to the folder. Then you can see
them in libraries.

[image: _images/image60.png]
For more details about Arduino IDE, go to Learning->Getting
started->Foundation on the arduino.cc and click Arduino
Software (IDE) on the page:

http://www.arduino.cc/en/Guide/Environment.

If your sketch fails the upload, on the same page click
Troubleshooting

http://www.arduino.cc/en/Guide/Troubleshooting.


Note


	If your computer is running on the Windows XP system, the new version
IDE will prompt errors when running the code. You are recommended to
download the Arduino 1.0.5 or Arduino 1.0.6. Or you can also upgrade
your Window system.


	All the experiments in this kit are done with SunFounder Uno R3
board, but they are also compatible with SunFounder Mega 2560,
SunFounder Mars, SunFounder Nano and all official Arduino Boards. All
the code included in this kit works with these boards.






So what does COMPATIBLE mean here? It means you can use any of the
three boards to do the same experiment with the same wiring. Simply
put, if the wire is connected to Pin 12 of Uno in the user manual,
likewise, you can connect it to Pin 12 on any other official Arduino
boards you are using. Then open the corresponding sketch and upload
them.

Now let’s begin!
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Lesson 1 Display by I2C LCD1602

Introduction

As we all know, though LCD and some other displays greatly enrich the
man-machine interaction, they share a common weakness. When they are
connected to a controller, multiple IOs will be occupied of the
controller which has no so many outer ports. Also it restricts other
functions of the controller. Therefore, LCD1602 with an I2C bus is
developed to solve the problem.

The blue potentiometer on the I2C LCD1602 (see the figure below) is used
to adjust the backlight for better display. I²C uses only two
bidirectional open-drain lines, Serial Data Line (SDA) and Serial Clock
Line (SCL), pulled up with resistors. Typical voltages used are +5 V or
+3.3 V although systems with other voltages are permitted.

[image: _images/image40.png]
Components


	1 * SunFounder Uno board


	1 * I2C LCD1602 module


	1 * USB cable


	1 * 4-Pin Dupont wire (M to F)




Principle

In this experiment, we will let I2C LCD1602 display “SunFounder” and
“hello, world” by programming.

Experimental Procedures

Step 1: Build the circuit







	I2C LCD1602

	SunFounder Uno/ Mega2560



	GND

	GND



	VCC

	5V



	SDA

	A4 (Uno)/Pin 20 (Mega2560)



	SCL

	A5 (Uno)/Pin 21 (Mega2560)







Note

The I2C LCD1602 is connected to Mega2560 differently compared with being done to Uno. PLEASE follow the wiring above.



[image: _images/image61.png]
Step 2: Open the code file

In the folder Sensor Kit V2.0 for Arduino you just downloaded and
unzipped, you can see the folder for the corresponding lesson which
includes two folders: code (the sketch) and circuit (Fritzing file).
Go to the code folder and find the .ino file (.ino is the format of
the sketch). Then double click to open it. You can also open an empty
.ino file and type in the code we provide.

Step 3: Select the Board and Port

Before uploading the code, you need to select the Board and Port.

Click Tools ->Board and select Arduino/Genuino Uno. If your
board is Mega2560, then select Arduino/Genuino Uno Mega or Mega2560.

[image: _images/image62.png]
Then select Tools ->Port. Your port should be different from mine.

[image: _images/image63.png]
Step 4: Upload the sketch to the SunFounder Uno board

Click the Upload icon to upload the code to the control board.

[image: _images/image64.png]
If “Done uploading” appears at the bottom of the window, it means
the sketch has been successfully uploaded.

[image: _images/image65.png]
Code
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Lesson 2 Analog Hall Sensor

Introduction

[image: _images/image5.png]
Based on the Hall Effect, a Hall sensor is a one that varies
its output voltage in response to a magnetic field. Hall sensors are
used for proximity switching, positioning, speed detection, and current
sensing applications.

Hall sensors can be categorized into linear (analog) Hall sensors and
switch Hall sensors. A switch Hall sensor consists of voltage regulator,
Hall element, differential amplifier, Schmitt trigger, and output
terminal and it outputs Boolean value (0/1). A linear Hall sensor
consists of Hall element, linear amplifier, and emitter follower and it
outputs analog values. If a comparator is added to a linear (analog)
Hall sensor, it can output both analog and digital signals.

Components


	1 * SunFounder Uno board


	1 * USB data cable


	1 * Analog Hall sensor module


	1 * 4-Pin anti-reverse cable


	1 * Magnet




Principle

Hall Effect

Hall Effect is a kind of electromagnetic effect. It was discovered by
Edwin Hall in 1879 when he was researching conductive mechanism about
metals. The effect is seen when a conductor is passed through a uniform
magnetic field. The natural electron drift of the charge carriers causes
the magnetic field to apply a Lorentz force (the force exerted on a
charged particle in an electromagnetic field) to these charge carriers.
The result is what is seen as a charge separation, with a buildup of
either positive or negative charges on the bottom or on the top of the
plate.

[image: _images/image67.png]
A Hall sensor is a magnetic field sensor based on it.

Electricity carried through a conductor will produce a magnetic field
that varies with current, and a Hall sensor can be used to measure the
current without interrupting the circuit. Typically, the sensor is
integrated with a wound core or permanent magnet that surrounds the
conductor to be measured.

In this experiment, when the sensor approaches the magnet, the value of
pin A0 will change. When the value exceeds the threshold set by the
potentiometer before, D0 will output low level and the corresponding LED
lights up.

The schematic diagram of the analog Hall sensor module:

[image: _images/image68.png]
Experimental Procedures

Step 1: Build the circuit

[image: _images/image69.png]
Step 2: Open the code file

Step 3: Select correct Board and Port

Step 4: Upload the sketch to the SunFounder Uno board

Code
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Lesson 3 Switch Hall Sensor

Introduction

[image: _images/image6.png]
A switch Hall sensor consists of voltage regulator, Hall element,
differential amplifier, Schmitt trigger, and output terminal. It outputs
digital values.

Components


	1 * SunFounder Uno board


	1 * USB data cable


	1 * Switch Hall sensor module


	2 * 3-Pin anti-reverse cable


	1 * Passive buzzer


	1 * Magnet




Principle

Hook up the switch Hall sensor module with pin 8 of the SunFounder Uno,
and the buzzer to pin 7. When an energized conductor approaches the
module, the output terminal SIG outputs low level; the buzzer beeps and
at the same time the corresponding LED lights up.

[image: _images/image72.png]
Experimental Procedures

Step 1: Build the circuit

The wiring between the switch Hall sensor and SunFounder Uno board:







	Switch Hall Sensor

	SunFounder Uno



	SIG

	8



	VCC

	5V



	GND

	GND






The wiring between the passive buzzer and SunFounder Uno board:







	Passive Buzzer

	SunFounder Uno



	SIG

	7



	VCC

	5V



	GND

	GND






[image: _images/image73.png]
Step 2: Open the code file

Step 3: Select correct Board and Port

Step 4: Upload the sketch to the SunFounder Uno board

Code
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Lesson 4 Analog Temperature Sensor

Introduction

A temperature sensor is a component that senses temperature and converts
it into output signals. By material and component features, temperature
sensors can be divided into two types: thermal resistor and
thermocouple. Thermistor is one kind of the former type. It is made of
semiconductor materials; most thermistors are negative temperature
coefficient (NTC) ones, the resistance of which decreases with rising
temperature. Since their resistance changes acutely with temperature
changes, thermistors are the most sensitive temperature sensors.

The Analog Temperature Sensor module uses an NTC thermistor, thus
measuring temperature sensitively. It also has a built-in comparator
LM393 which enables the module to output both digital and analog signals
at the same time. The module can be used for temperature alarm and
temperature measurement.

[image: _images/image5.png]
Components


	1 * SunFounder Uno board


	1 * USB data cable


	1 * Analog temperature sensor module


	1 * 4-Pin anti-reverse cable




Principle

There is a comparator LM393 on the analog temperature sensor module. You
may set a threshold by the potentiometer on it. When you touch the
thermistor, the value of A0 decreases. Once the value is lower than the
threshold, D0 will output high level and the indicator LED on the analog
temperature sensor module and that attached to pin 13 of the SunFounder
Uno will go out. You can check the value of A0 and D0 on Serial Monitor.
The schematic diagram of the module:

[image: _images/image76.png]
Experimental Procedures

Step 1: Build the circuit

[image: _images/image77.png]
Step 2: Open the code file

Step 3: Select correct Board and Port

Step 4: Upload the sketch to the SunFounder Uno board

Code
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Lesson 5 Temperature Detection by Thermistor

Introduction

[image: _images/image7.png]
As mentioned in Lesson 4, thermistors are the most sensitive
temperature sensors because their resistance changes acutely with
temperature changes. Therefore, the thermistor sensor module measures
temperature sensitively though it can output only analog signals. The
module is often used to detect the temperature changes in ambient
environment.

Components


	1 * SunFounder Uno board


	1 * USB data cable


	1 * Thermistor module


	1 * I2C LCD1602 module


	1 * 3-Pin anti-reverse cable


	1 * 4-Pin anti-reverse cable


	1 * Dupont wire (F to F)




Principle

How a thermistor works: its resistance varies significantly with the
ambient temperature. It can detect surrounding temperature changes in a
real-time manner and send the temperature data to analog I/O port of the
SunFounder board. What you need to do is convert the output to Celsius
temperatures by simple programming and then display it on an LCD.

The schematic diagram of the module:

[image: _images/image79.png]
Experimental Procedures

Step 1: Build the circuit

[image: _images/image80.png]
Step 2: Open the code file

Step 3: Select correct Board and Port

Step 4: Upload the sketch to the SunFounder Uno board

Code
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Lesson 6 Auto-flash LED

Introduction

[image: _images/image6.png]
The 7-color auto-flash LED module can automatically flash built-in
colors after power on. It can be used to make quite fascinating light
effects.

Components


	1 * SunFounder Uno board


	1 * USB data cable


	1 * 7-color auto-flash LED module


	1 * 3-Pin anti-reverse cable




Principle

When it is power on, the 7-color auto flash LED will flash built-in
colors. The schematic diagram of the module:

[image: _images/image82.png]
Experimental Procedures

Just connect pin VCC of the module to 5V of the SunFounder Uno board and
pin GND to GND.


Note

There are two GND pins on the module. You only need to connect one of them.



[image: G:\电路图sensor kit\Frizting 图\05 Auto-flash LED.png]
Now, you should see the LED flashing seven colors.

[image: \_MG_0431]
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Lesson 7 Barometer BMP180

Introduction

[image: _images/image7.png]
The BMP180 barometer is the new digital barometric pressure
sensor, with a very high performance, which enables applications in
advanced mobile devices, such as smart phones, tablets and sports
devices. It complies with the BMP085 but boasts many improvements, like
a smaller size and more digital interfaces.

Components


	1 * SunFounder Uno Board


	1 * USB Cable


	1 * BMP180 Module


	Several Jump Wires


	1* Breadboard




Principle

The schematic diagram of the module:

[image: IMG_256]
Experimental Procedures

Step 1: Build the circuit







	BMP180

	SunFounder Uno/Mega2560



	VCC

	5V



	GND

	GND



	SCL

	A5/Pin 21 Mega2560



	SDA

	A4/Pin 20 Mega2560






[image: _images/image86.png]
Step 2: Open the code file

Step 3: Select correct Board and Port

Step 4: Upload the sketch to the SunFounder Uno board

Code


  
    
    
    Lesson 8 Real-time Clock Module
    

    

    
 
  

    
      
          
            
  
Lesson 8 Real-time Clock Module

Introduction

Nowadays there are many popular serial clock circuits such as DS1302,
DS1307, PCF8485, etc. They are widely used for simple interface, low
cost, and ease of use. In this lesson, we will use the DS1302 real-time
clock (RTC) module to obtain current date and time.

[image: _images/image8.png]
Components


	1 * SunFounder Uno board


	1 * USB data cable


	1 * RTC-DS1302 module


	1 * I2C LCD1602 module


	1 * 5-Pin anti-reverse cable


	1 * 4-Pin anti-reverse cable


	1 * Dupont wire (F to F)




Principle

DS1302 is a trickle charging clock chip, launched by DALLAS in America.
With a built-in real-time clock/calendar and a 31-byte static RAM, it
can communicate with MCU through simple serial ports. The real-time
clock/calendar circuit provides information about second, minute, hour,
day, week, month, and year. DS1302 can automatically adjust the number
of days per month and days in leap year. You can determine to use a
24-hour or 12-hour system by AM/PM selection. It can simply communicate
with MCU in synchronous serial way and only needs to use three port
cables: Reset (RST) cable, I/O data (SDA) cable and serial clock (SCL)
cable. The schematic diagram of the module:

[image: _images/image89.png]
Experimental Procedures

Step 1: Build the circuit

The wiring between DS1302 and SunFounder Uno board is as shown below:







	DS1302

	SunFounder Uno



	SCL

	7



	SDA

	6



	RST

	5



	VCC

	3.3V



	GND

	GND






[image: _images/image90.png]
Step 2: Open the code file

Step 3: Select correct Board and Port

Step 4: Upload the sketch to the SunFounder Uno board

Code
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Lesson 9 Flame Alarm

Introduction

[image: _images/image9.png]
A flame sensor module performs detection by capturing infrared
wavelengths from flame. It can be used to detect and warn of flames.

Components


	1 * SunFounder Uno board


	1 * USB data cable


	1 * Flame sensor module


	1 * Passive buzzer module


	1 * 4-Pin anti-reverse cable


	1 * 3-Pin anti-reverse cable




Principle

There are several types of flame sensors. In this experiment, we will
use a far-infrared flame sensor. It can detect infrared light with a
wavelength ranging from 700nm to 1000nm. A far-infrared flame probe
converts the strength changes of the external infrared light into
current changes. And then it converts analog quantities into digital
ones.

In this experiment, connect pin D0 to the digital port 8 of the
SunFounder board. Then when the flame sensor detects flame signals, the
buzzer beeps and the corresponding LED lights up. When it detects no
flame signals, the buzzer stops and the LED goes out.

The schematic diagram of the module:

[image: _images/image92.png]
Experimental Procedures

Step 1: Build the circuit

The wiring between the flame sensor and SunFounder Uno board:







	Flame Sensor

	SunFounder Uno



	D0

	8



	A0

	A0



	VCC

	5V



	GND

	GND






The wiring between the passive buzzer and SunFounder Uno board:







	Passive Buzzer

	SunFounder Uno



	SIG

	7



	VCC

	5V



	GND

	GND
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Step 2: Open the code file

Step 3: Select correct Board and Port

Step 4: Upload the sketch to the SunFounder Uno board

Code
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Lesson 10 Flammable Gas Detection

Introduction

[image: _images/image10.png]
Gas Sensor MQ-2 is a sensor for flammable gas and smoke by
detecting the concentration of combustible gas in the air. They are
often used in gas detecting equipment for smoke and flammable gasses
such as LPG, i-butane, propane, methane and alcohol in household,
industry or automobile.

Components


	1 * SunFounder Uno board


	1 * USB data cable


	1 * MQ-2 gas sensor module


	1 * 4-Pin anti-reverse cable




Principle

MQ-2 gas sensor applies SnO2 (an oxygen-deficient n-type semiconductor)
which has a lower conductivity in the clear air as a gas-sensing
material. In an atmosphere where there may be inflammable gases, the
conductivity of the gas sensor raises along with the inflammable gas
concentration increases. MQ-2 performs a good detection to different
inflammable gases such as natural gas, especially sensitive to liquefied
gas, propane and hydrogen.

In this experiment, release some combustible gas around the sensor and
the value at A0 increases. Once the concentration of the gas exceeds a
limit, D0 outputs low level and the corresponding LED will light up.
Please note that the sensor needs burn-in time so the readings can be
more consistent and reliable.
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Experimental Procedures

Step 1: Build the circuit
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Step 2: Open the code file

Step 3: Select correct Board and Port

Step 4: Upload the sketch to the SunFounder Uno board

Code
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Lesson 11 Humiture Detection

Introduction

[image: _images/image11.png]
The digital temperature and humidity sensor DHT11 is a
composite sensor that contains a calibrated digital signal output of
temperature and humidity. The technology of a dedicated digital modules
collection and the temperature and humidity sensing technology are
applied to ensure that the product has high reliability and excellent
long-term stability.

The sensor includes a resistive sense of wet component and an NTC
temperature measurement device, and is connected with a high-performance
8-bit microcontroller.

Components


	1 * SunFounder Uno board


	1 * USB data cable


	1 * Humiture sensor module


	1 * I2C LCD1602


	1 * 3-Pin anti-reverse cable


	1 * 4-Pin anti-reverse cable


	1 * Dupont wire (F to F)




Principle

Only three pins are available for use: VCC, GND, and DATA. The
communication process begins with the DATA line sending start signals to
DHT11, and DHT11 receives the signals and returns an answer signal. Then
the host receives the answer signal and begins to receive 40-bit
humiture data (8-bit humidity integer + 8-bit humidity decimal + 8-bit
temperature integer + 8-bit temperature decimal + 8-bit checksum).

[image: _images/image98.png]
For more information, please refer to the datasheet of DHT11.

The schematic diagram

[image: _images/image99.png]
Experimental Procedures

Step 1: Build the circuit
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Step 2: Open the code file

Step 3: Select correct Board and Port

Step 4: Upload the sketch to the SunFounder Uno board

Code
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Lesson 12 Joystick PS2

Introduction

A joystick is an input device consisting of a stick that pivots on a
base and reports its angle or direction to the device it is controlling.
Joysticks are often used to control video games and robots. A Joystick
PS2 is used here.

[image: _images/image12.png]
Components


	1 * SunFounder Uno board


	1 * USB data cable


	1 * Joystick PS2 module


	1 * 5-Pin anti-reverse cable




Principle

This module has two analog outputs (corresponding to X and Y
coordinates) and one digital output representing whether it is pressed
on Z axis.

[image: _images/image102.png]
Experimental Procedures

Step 1: Build the circuit

The wiring between the Joystick PS2 and SunFounder Uno board:







	Joystick PS2

	SunFounder Uno



	GND

	GND



	VCC

	5V



	Bt

	7



	x

	A0



	y

	A1
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Step 2: Open the code file

Step 3: Select correct Board and Port

Step 4: Upload the sketch to the SunFounder Uno board

Code
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Lesson 13 Controlling an LED by Button

Introduction

[image: _images/image13.png]
As you can see, an LED has been attached to pin 13 on most of the
SunFounder boards already. So just a button module can be used to build
a simple circuit to make the LED light up.

Components


	1 * SunFounder Uno board


	1 * USB data cable


	1 * Button module


	1 * 3-Pin anti-reverse cable




Principle

Since the LED has been attached to pin 13, just connect the button
module to digital pin 7. When the button module identifies inductive
button-pressing signals, the LED will be on. Otherwise it will be off.
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Experimental Procedures

Step 1: Build the circuit
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Step 2: Open the code file

Step 3: Select correct Board and Port

Step 4: Upload the sketch to the SunFounder Uno board

Code
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Lesson 14 Vibration Switch

Introduction

[image: _images/image14.png]
A vibration switch, also called spring switch or shock
sensor, is an electronic switch which senses vibration amplitude and
transfers the signals to a circuit device thus switching on the circuit.
It composes of conductive vibration spring, switch, trigger pin, and
packaging agent.

Components


	1 * SunFounder Uno board


	1 * USB data cable


	1 * Vibration switch module


	Jumper wires




Principle

In a vibration switch module, the conductive vibration spring and
trigger pin are precisely placed in the switch and fixed by adhesive.
Normally, the spring and the trigger pin are separated. Once the sensor
detects shock, the spring will vibrate and contact with the trigger pin,
thus conducting and generating trigger signals. The schematic diagram:

[image: _images/image108.png]
Experimental Procedures

Step 1: Build the circuit

With the LED attached to pin 13 already, connect the vibration switch to
digital pin 8. When the vibration switch generates vibration signals,
pin SIG will output low level, and the LED on the module and that
attached to pin 13 will light up.
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Step 2: Open the code file (Lesson 14 Vibration Switch)

Step 3: Select correct Board and Port

Step 4: Upload the sketch to the SunFounder Uno board

Code
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Lesson 15 Touch Switch

Introduction
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A metal touch sensor is a type of switch that only operates when it’s
touched by a charged body. It has a high-frequency transistor which is
energized when receiving electromagnetic signals.

Components


	1 * SunFounder Uno board


	1 * USB data cable


	1 * Touch Switch module


	1 * 3-Pin anti-reverse cable




Principle

In this experiment, touch the base electrode of the transistor to make
it conduct electricity, for human body itself is a kind of conductor and
an antenna that can receive electromagnetic waves in the air.
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Experimental Procedures

Step 1: Build the circuit
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Step 2: Open the code file

Step 3: Select correct Board and Port

Step 4: Upload the sketch to the SunFounder Uno board

Code
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Lesson 16 Photo-interrupter

Introduction

[image: _images/image16.png]
A photo-interrupter is a sensor with a light-emitting
component and light-receiving component packaged face to face. It
applies the principle that light is interrupted when an object passes
through the sensor. Therefore, photo-interrupters are widely used in
speed measurement.

Components


	1 * SunFounder Uno board


	1 * USB data cable


	1 * Photo-interrupter module


	1 * 3-Pin anti-reverse cable




Principle

Basically a photo-interrupter consists of two parts: transmitter and
receiver. The transmitter (e.g., an LED or a laser) emits light and then
the light goes to the receiver. If the light beam between the
transmitter and receiver is interrupted by an obstacle, the receiver
will detect no incident light even for a moment and the output level
will change. In this experiment, we will turn an LED on or off by using
this change.
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Experimental Procedures

Step 1: Build the circuit

[image: _images/image115.png]
Step 2: Open the code file

Step 3: Select correct Board and Port

Step 4: Upload the sketch to the SunFounder Uno board

Code
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Lesson 17 Ph